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PREFACE

Welcome to the Oracle Insurance Insbridge Rating and Underwriting Installation and Upgrade
Guide. The Insbridge Rating and Underwriting (IBRU) System is a browser-based, multiplatform
insurance rating and underwriting technology solution that provides integrated management for
every aspect of the rate definition and modification process. This guide will help with the
upgrading of the Insbridge Rating and Underwriting System.

AUDIENCE

This guide is intended for system administrators, installers, database administrators and others
tasked with installing and configuring the IBRU system and associated databases.

TYPES OF INSTALLATION

There are various types of installations:

Windows Environment

o Full RateManager — This installation will install RateManager and the Insbridge
Framework Administrator (IBFA). This is for a Windows only environment, using a SQL
Server database.

o Full SoftRater for Windows Node — This installation is for existing environments that

want to add a SoftRater for Windows node to an environment. This is for a Windows only
environment. This installation also includes incorporating an Oracle Database.

Java Environment

o Full SoftRater Installation on a Java Machine — This installation will install SoftRater
on a Java machine, using a SQL Server database.

o Full SoftRater Installation on a Java Machine — This installation will install SoftRater
on a Java machine, using an Oracle database.

Upgrading

e Upgrade — This installation is for existing customers and will take their current version of
IBRU up to version 04.05.00.

This guide will describe Upgrading an existing environment.
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Definitions

Some commonly used terms when installing or using the Oracle Insurance Insbridge Rating and
Underwriting system:

e IBRU - Insbridge Rating and Underwriting System. This is the entire system.

e IBFA —Insbridge Framework Administrator. IBFA is an administrative tool used to
configure Insbridge applications and setup RateManager database connections. IBFA will
be located on a Windows Server machine. IBFA/SR-WIN is an Insbridge Framework
Administrator/SoftRater for Windows.

e IBSS - Insbridge SoftRater Server. IBSS is the administrative tool for the SoftRater
engine. The SoftRater engine is a multi-platform component within IBRU that executes
the rules, rating and underwriting instructions as defined by the user in RateManager.
IBSS is usually located on a Java machine. IBSS/SR-JAVA is an Insbridge SoftRater
Server/SoftRater for Java.

o SoftRater Node — A SoftRater node is either an IBFA (without RateManager) or IBSS
instance on a physical environment.

o SoftRater Native — SoftRater Native is a remote instance of SoftRater that can execute
rules and rating logic in environments where access via the SoftRater web-services is not
desired or possible.

¢ RM — RateManager. RateManager is a component within IBRU that enables users to
manage the product definition and modification process, including rating and underwriting
logic.

e SR — SoftRater. The engine that executes the rating, rules and underwriting instructions
defined within RateManager. The rating environment for runtime execution and
processing of business content. SoftRater can be further defined by the operating system
where it has been loaded.

e SR-WIN — SoftRater for Windows. This is also another name for IBFA.
e SR-JAVA - SoftRater for Java. This is also another name for IBSS.

e SRP — SoftRater Packages. A package that holds all the RateManager logic for a specific
program and version.

e VFS —Virtual File Servers. Virtual file server management allows you to access
environments that are located on other machines in different locations where packages
can be downloaded.

o Package Location — A pointer to a location where SoftRater Packages (SRP’s) are
stored.

e Physical Environment — A physical environment is generally referred to as a physical
machine.

e Authoring Environment — The physical machine where RateManager is installed.

e Rating Environment — The physical machine(s) where SoftRater is installed. This is
typically the same as a SoftRater node.
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e Logical Environment — An environment created for a subscriber in IBFA. It defines
package location, engine location and database location in addition to several other
supporting data items. This environment is used for rating and/or SRP management.
Each database connection will have a logical environment.

Related Documents

For more information, refer to the following Oracle resources:

e The Oracle Insurance Insbridge Rating and Underwriting Operating Environments for
Hardware and Software.

e You can view this guide on-line at this address:

http://www.oracle.com/technetwork/documentation/insurance-097481.html

Manual History

New editions incorporate any updates issued since the previous edition.

Publication Product

Edition . Publication Date Comment
Number Version
“1¥ Editon _ P01-788-01 May 2011 Initial Release
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Chapter 1

SYSTEM UPGRADE REQUIREMENTS

Prior to upgrading an IBRU system, please have ready:
e The Insbridge User Account information.
e The location of the current IBRU installation.
e Prior to running an IBRU upgrade, please make sure all users are logged off.

e The Insbridge User has administrative rights or proper permissions to run an installation
and start the Insbridge Message Service and the Insbridge Task Manager Service.

e You must run as Administrator for a Windows 2008 Server upgrade.
e User name and password for RateManager.
OR

e Access to the IBRU databases. Updates will be run against the IBRM and the IB_CLIENT
databases. SoftRater databases may not require an update.

NOTE: Upgrades are performed the same way for either a 32-bit machine or a 64-bit machine.
The same permissions and requirements are needed and should already be set up.

NOTE: If you attempting to update from a 32-bit Insbridge instance to a 64-bit Insbridge instance,
please contact Oracle Support.

Special Considerations for SQL Server in a Java Setup

For Java setups only when connecting to SQL Server from IBSS:
e For Upgrades: If you want to keep the current Environment settings that are in IBSS,
there are additional steps that need to be performed. Please see the SQL Server
Upgrade chapter in the corresponding SoftRater Installation Guide for the exact steps.

If you are running a Windows only environment, no additional steps will be required. This is only
for SoftRater for WebLogic, SoftRater for WebSphere and SoftRater for JBoss.

E-Delivery

Prior to installation, please make sure the source machine(s) where IBRU will be loaded has an
unzip utility. An unzip utility for most platforms is available on the E-Delivery download page.
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Documentation from E-Delivery is in PDF format. Prior to installation, please make sure the
source machine(s) where IBRU documentation will be loaded has a PDF reader.

Files are downloaded with part numbers as file names. Please make note of the part numbers
you have downloaded and the corresponding file name. You may be asked to provide the part
numbers or the filename if you contact Oracle Insurance Support.

The installation downloads you can select are:

Insbridge IBRU Install — This is required for all RateManager installations
SoftRater for WebSphere — This is required if you are using WebSphere
SoftRater for WebLogic — This is required if you are using WebLogic
SoftRater for Jboss — This is required if you are using Jboss

Documentation — It is recommended that you download the documentation. Installation
guides and user guides are located here.

The 04.05-Insbridge-IBRU folder contents:

- Databases
¢ DB2
- SoftRater — IBSR
o DDL
¢ Oracle
- SoftRater — IBSR
o DDL
0 Update:Usp_IBSR_v04.05.00.oracle
¢ SQL Server
- RateManager — IBRM
0 Latinl_General _BIN
= DATABASE_BACKUP_IBRM_TEMPLATE_CASE_SENSITIVE.bak
0 SQL_Latinl_General CP1_CI_AS
= DATABASE_BACKUP_IBRM_TEMPLATE.bak
- Security — IB_CLIENT
0 SQL_Latinl_General_CP1_CI_AS
= DATABASE_BACKUP_IB_CLIENT_TEMPLATE.bak
- SoftRater — IBSR
0 Latinl _General BIN
= DATABASE_BACKUP_IBSR_TEMPLATE_CASE_SENSITIVE.bak
0 SQL_Latinl_General CP1_CI_AS
= DATABASE_BACKUP_IBSR_TEMPLATE.bak
0 Update:Usp_ IBSR_v04.05.00.sql

- IE7_IE8 Users
¢ Insbridge IE7 Active X Control Update PDF
¢ RateManager_IE7_IE8.exe

- Oracle Bl Publisher
¢ OBl _PUBLISHER.exe

- Oracle Client
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¢ Oracle_client.exe

- Oracle Insurance — Insbridge Rating and Underwriting.exe

You will be required to run the installation file and create the IB_CLIENT database for any new
installation. The other folders and files may not be needed, depending upon the kind of setup you
want. Everything for a Windows only installation is in the 04.05.00-Insbridge-IBRU folder. If you
want to incorporate a Java environment, please download the corresponding SoftRater file.
SoftRater downloads are not required if you are running in Windows only.

10
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UPDATING AN INSBRIDGE APPLICATION

An update to the IBRU system is run from the Oracle Insurance — Insbridge Rating and

Underwriting.exe. Unzip the IBRU folder on the machine where the IBRU system (IBFA and
RateManager) is currently installed.

To update the IBRU system:
1. Run the IBRU application

2. Update the databases
After running the updates, please review the Preference settings.

If you are updating from 3.13.7 or previous, you may want to run the Migrate Files option.
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STEP 1 — RUNNING THE IBRU APPLICATION

1. Begin with the Oracle Insurance - Insbridge Rating and Underwriting Install file.

NOTE: The installation program requires that the installer have administrator rights on the
machine where the install is occurring.

NOTE: Please close all open applications before running the Oracle Insurance — Insbridge
Rating and Underwriting file.

2. Open the Oracle Insurance — Insbridge Rating and Underwriting file. A Welcome screen will
be displayed.

{iF Dracle Insurance - Insbridge Rating and Underwriting 04.05.00 Setup [_ ] |

4 Oracle Insurance Insbridge Rating and Underwriting

It iz strongly recommended that you exit all Windows programs before running this setup program.

Click Cancel to quit the zetup program, then cloze any programs you have running. Click Hest to
continue the inztallation,

WARMIMNG: Thiz program iz protected by copuright law and international reaties.

[Inauthorized reproduction or distribution of this program, or any portion of it may result in zevere civil
and criminal penalties, and will be prozecuted to the masimum extent pozsible under law,

ORACLE

INSURANCE

Cancel |

Figure 1 Installing Insbridge

3. Click on Next to continue.

12
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i'él Oracle Insurance - Insbridge Rating and Underwriting 04.05.00 Setup M= E3 |

Destination Folder ORACLE

Select a folder where th lic:ati ill be installed.
elect a folder where the application will be installe INSURANCE

The ‘ize Installation wizard will inztall the filez far Oracle Insurance - Inzbridge B ating
and Undenwriting in the following folder.

To inztall into a different folder, click the Browse button, and zelect anaother folder.
You cah choogze not ta install Oracle Inzurance - Insbridge B ating and Undenariting by
clicking Cancel to exit the YWize Installation ‘wWizard.

Destination Faolder
{E:'&F‘HDGHAM FILESSORACLEMGBUMMSERIDGE®,

Wize Installation Wizard [R]

Figure 2 Destination Location for Update

4. The destination path will be displayed next. This is an information only screen. No changes
will be allowed. Click Next.

13



Chapter 2 — Updating the Insbridge Application

{i# Dracle Insurance - Insbridge Rating and Underwriting 04.05.00 Setup [_ ] |

Logon Information DRACLE'

The following logan information is uzed by Inzbridge. INSURANCE

Specify a user account to be uzed by the application, either for winning a service or for
logaing onto other zervers. Uze the Browse button to chooze uzers from pour network.,
For domainz, uzer names must be in the format of DOMAINS 2k ame.

Uszer Mame: |Insl:uriu:lge Browse. .. |

Pazzward: | mim

Create Mew Uszer...

Wwize [nstallation ‘wizard [R]

Cancel |

< Back

Figure 3 Entering User Information for Insbridge

5. The next screen is the Logon Information screen. Please use the Insbridge user account
information that you set up for the initial installation. Click Next to continue.

14
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{i# Dracle Insurance - Insbridge Rating and Underwriting 04.05.00 Setup [_ ] |

Select Features DRACLE'

Pleaze zelect which features you would like to install, INSURANCE

Feature Description:

_ Oracle Inzurance Inzbridge Rating and
e = e | IBFA IUndenwriting iz a web-based rating, rules, and
- vl Oracle Bl Publizher Reports underwiiting system.

= {Q "I Inzbridge R ating & Underwriting
b (=0 | B aterd anager

Thiz feature will be inztalled an the local hard
drive.

Thizs feature requirez OKB on vour hard drive. [t
has 2 of 2 subfeatures selected. The subfeat...

Current location:
C:A\PROGRAM FILESYWORACLEMGEUSMSERIDGE®

Wize Installation wizard [R]
Digk Cost Rezet

Figure 4 Selecting Features to Install

6. The next screen will list the applications to be installed. To expand the options and view
details, click on the downward arrow. All features are checked for installation. RateManager
is the only one that you will be allowed to not install. Click Next.

Options are:

e Insbridge Rating and Underwriting:
The default option is: Entire feature will be installed on local hard drive.
You will not be able to opt out of this selection.

e RateManager:
The default option is: Entire feature will be installed on local hard drive.
You will be able to opt out of this option. Select Entire Feature will be
unavailable. RateManager will not be installed.

e IBFA:
The default option is: Entire feature will be installed on local hard drive.
You will not be able to opt out of this selection.

e Oracle Bl Publisher:
The default option is: Entire feature will be installed on local hard drive.
You will not be able to opt out of this selection.

This option does not install the OBI Publisher. Only the templates required by the IBRU
application will be installed on local hard drive.

15
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{i# Dracle Insurance - Insbridge Rating and Underwriting 04.05.00 Setup [_ ] |

Ready to Install the Application OoORACLE

Click Mext to begin installation. INSURANCE

Chek the Back buttan ta reenter the inzstallabon information or clhick Cancel to exit
the wizard.

Wize Installation wizard [R]

Figure 5 Ready to Install

7. A Ready to Install screen will be displayed. If you are ready, click Next. Otherwise click Back
to check the options you want to install. A progress screen will display your progress.

jiz Dracle Insurance - Insbridge Rating and Underwriting Setup [_ | |

Updating System ORACLE

The features you selected are curmently being installed.
Y v heing INSURANCE

Walidating install...

Wize Installation Wizard [R]

16
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8. When complete, a ReadMe Information screen will be displayed.

ji& Oracle Insurance - Insbridge Rating and Underwriting 04.05.00 Setup [_ | |
Readme Information DRACLE'
Inzbridae haz been succeszfully installed. INSURANCE
Microsoft Windows 2003/2008 Server -

A full installation of Microsoft Server 2003,/2003 is required. The fallowing
configuration assumes that the administrator of the server to be generally
familiar with managing a VWindows sener,

Internet Information Services (l15)

The InsBridge Rating and Undenwriting System is a web based application and
requires IIS to be installed before installation to facilitate the default web virtual
directories creations.

The subcomponents of I3 needed by IBRLL

. Common Files
. Documentation
. Internet Infarmation Services Snap-In |

“Wize Inztallabion Yizard®

9. Click Finish to finish the installation. The installation should complete successfully.

NOTE: Any Insbridge services will be stopped during the update.

17
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STEP 2 — UPDATING DATABASES

Database updates can be performed in RateManager for the IBRM and IB_Client databases. This
is the recommended way to update these databases. The SoftRater database will need to be
updated manually on the machine where it is located.

To update the RM and IB_Client databases, log into RateManager.

NOTE: If you need to go from an older version, such as 3.9, you will have to enter RateManager
and run the IBRM and IB_CLIENT update scripts in sequential order from there. You
must be a DB Owner to run the update scripts in RateManager.

NOTE: SoftRater update scripts must be run manually. See Manual Updates to the IBRU
Databases for more information.

Updating Databases in RateManager

The URL for RateManager will be http://INSTALLATIONSERVERNAME/RM. Where Installation
server is the server where RateManager was installed. This will place you on the RateManager
login screen.

If you log into RateManager and Tools is the only option, you must perform a database update.

/= Oracle Insurance Insbridge RateManager 04.05 - Windows Internet Explore

ORACLE  Insurance Insbridge RateManager
File | Tools Help

3 Database » P Backups
(& Updates

Hom

Figure 6 Tool Mandatory Update

1. Enter your username and password.

2. Navigate to the Tools-»Database->Updates.

On the DB Updates screen, the current version will be highlighted and the status will be
Current. The updates below the current version will be grayed out. These updates cannot
be run again. You will receive an error message if you attempt to run a lower version
update. Any version update above the current version will also be grayed out but will be
available for executing.

18


http://installationservername/RM

Chapter 2 — Updating the Insbridge Application

Updates have to be installed sequentially, meaning if you are on Version 03.13, you must
run the 04.00 update, the 04.01 update and finally the 04.05.00 update. If you attempt to
run an update that is more than one level above the current version, you will receive an
error message.

3. The Updates tab will be displayed. Select the database you want to view from the Show
updates for drop down. The database updates for your selection will be listed. The last
column, the Status column, will show you which update is the Current one installed.

ORACLE" Insurance Insbridge RateManager

File Tools Help

Home DB Updates ®

(@ DB Updates

&" Execute Lledate Sn:riE EE DEEH Lledate Script E Save Update Script to File E’ﬂ Refresh

Show updates for:| IERM W
Scnpt Release Date Database Status
v04.05.00.00 5/1/2011 IBR.M
vO4.01.00.00 11/15/2010 IBR.M

vO<4,00.0.00 3/10/2010 IBR.M

v03.13.0.00 12/15/2009 IBR.M

03.12.0 4430/ 2009 IBR
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Figure 7 Available Updates

4. There are two ways to execute an update:
a. Directly in RateManager
b. In SQL Server

Directly in RateManager

This is recommended way to update a database. It is recommended that you start by selecting
the update showing Current. This will assure that the database showing as Current will have all
possible updates.

1. Highlight the update you want to run.

2. Click EXECUTE UPDATE SCRIPT. A warning message will be displayed.

19
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3. Click OK to run the update or Cancel to return to the previous screen.

4. Do this for both the IBRM database and the IB_CLIENT database.

2 Confirm LUpdate -- Webpage Dialog @

™ Are you sure you want to replace the
!‘/l current database's contents with the
selected release script on disk?

i Ok | & cancel |

Figure 8 Updating Scripts in RateManager

In SQL Server

This method should be performed by a database administrator. No warning message will be
displayed if you execute scripts in the wrong order. You must know the name of the databases
you are updating. Please see Manual Updates to the IBRU Database.

After you perform the database updates, to view all menu options, click File>Reload.

20
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UPDATING PREFERENCES

Administrators can edit web settings at any time from the Preferences option in RateManager.
Changes will take place after the user sessions have been ended. If web settings are changed
while the users are inside the module, the change will not be visible to them. Prior to users
accessing RateManager for the first time, it is recommended that Preferences be set.

To Change Settings

1. Select Tools=>Preferences.

Tools Help

Manage Lines

Aodit

Security ]

Database 3

&
S|
% Impart Pragrams
&
8

Zhange Password

371 Preferences

2. This will open the Preferences window. Select Web Settings.

21
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& Oracle Insurance Insbridge RateManager [Preferences] -- Webpage Dialog

Preferences

-Home Fage
[=-Administratar
L-Web Settings

Web Settings

Insbridge Configkml Path: |C:‘;PRDGRF| M FILES\ORACLE\IGEU\INSERIDGE\FRAM E‘NDRK‘;#

Messaging Server : |lD:a|tht

| {Secure Channel} I:l

SoftRater Server : |kxalhc\rsl

| {Secure Channel} I:l

Backup Share Folder |
Location:

Use Insbridge Com+

Admin:
Enforce Release Packaging:
Batch Package Threads:
Minimum Login User ID -
Length: n

User must changes

password: (Days)
Show Orverride Date Mask:
Allows Datz Type Change:

Inactive Session Time Out: El {hrs)

Batch Results with Mewline:

Online Help Server: ||D:a|hnsl |
My Recent List:
Deefault Prosy Script T -

i |https/fvepad vip=d.dat |

Change Control:

Maximum amount of

¥ Save | @ Close |

Figure 9 Preferences Settings

3. Make any necessary changes. If you do not know all the settings, you can come back
and edit lat a later time. It is recommended that you update the ONLINE HELP Server

immediately.

4. When you are finished, click SAVE to update your settings.

Web Settings

Insbridge ConfigXml Path

This is the path from IBFA. This pathway must match the IBFA path. You may need to change
this path if you have changed the path in IBFA. Please contact Insbridge support for further
information. It is strongly recommended that you leave the default.

Messaging Server

RateManager is set up to run batches on the same server that RateManager is located on. If you
have an especially large batch to run and you want to batch to a different server, you will have to
change server locations here. Unless necessatry, it is strongly recommended that you leave the

default.
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SoftRater Server

If you need to rate on another server, you will have to change server locations here. It is strongly
recommended that you leave the default.

Backup Share Folder Location

When you make backups of the RateManager database, you can specify the location of the
backup file. If the location is local, you will use a local path. If the location is not local, you must
be a disk admin to change.

Use Insbridge Com + Admin

This setting must always be true. If there is a conflict, please contact Oracle Insurance support.

Enforce Release Packaging

When set to False, a release is not required in order for users to create a SoftRater (full)
package. False is the default setting.

If setto True, a release is required in order for a SoftRater (full) package to be created. If a user
wants to create a SoftRater (full) package in the Program Explorer module, a release must be
created in the Releases area first. This release must have the program added to it and be
unlocked. When the user creates the SoftRater package in Program Explorer, they will have the
option to select the Release they want this package to be placed into. If there is no release, or no
release that contains that program and is unlocked, then the user will be able to do RateManager
(local) packages only.

Batch Package Threads

RateManager allows you to change how many threads are used. Threading enables a process to
finish faster by splitting the process into smaller processes that run quasi-simultaneously. On
multiprocessor systems, using multiple threads enables the operating system to assign the
threads to different processors.

In addition, the Framework Administrator also enables you to change the administrator email
address for each client. When a process fails, an email will be sent to the person who initiated the
process, as well as to the administrator email addresses listed for the client of that process.

NOTE: Before changing the number of threads, you should consult with your system
administrator. Setting the number too high can result in poor performance or even
a system crash. If you are unsure of how many threads to use, set the number to 1.
For single processor systems, Oracle Insurance recommends a maximum of 2
threads.

Minimum Login User ID Length

This is the minimum number of characters required for a user ID.
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User must change password

This where you set the number of days before a user is required to change his/her password.
This setting will only be active when you elect to have users change their password on the user
setup screen.

Show Override Date Mask

If enabled, a date mask for ‘Date’ data types will be displayed when importing a table. If not
enabled, this field will not be visible.

Allow Data Type Change
The type of data associated with a parameter. RateManager supports three (decimal, integer and
string) data types for variables and inputs and a fourth (date) for inputs and result variables only.

Setting this option to True will allow RateManager users change the data type of a variable or
input. Setting this option to False will not allow users to change data types.

Inactive Session Time Out

This is the amount of time that a user sits inactive before being automatically logged out of the
system.

Batch Results with New Line

Allows batch results to go to a new line instead of forming one continuous string. A True setting
will place a carriage return between result files. A False setting will result in one continuous string
without a break.

Online Help Server

Online help is installed with RateManager. This setting should be the server name where
RateManager currently resides. Either a server name or an IP address can be entered here. If
needed, you can change the name of the server. For example, if the machine name is not the
same as the host name, you may need to change the name in order for online help to function.

Change Control

If change control is on, it will be mandatory for users to enter a change control entry and
justification to any element or program when it is revisioned. If change control is off, the option will
not be presented.
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MIGRATE WORK FILES

This feature will migrate work files from previous versions of RateManger to release 4.5. Work
files are rating, pricing, mapping and template files used in various areas of RateManager such
as Impact Analysis, Library and Testing. Migrating files will allow users to access work files that
were available in previous releases of RateManager. If you do not migrate work files from

previous versions, users will not have access to them.

Work files should be migrated after the initial upgrade has been run, but can be run at any time

after.

MIGRATING FILES

Prior to migrating files, please create backup copies of the files to be migrated. This will require

access to the server were RateManager has been installed.
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[0 Framewark
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£ Meafee
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The location of previous RateManager installations:

-1 Program Files\InsBridge\Webs\RM:oo¢

where ¢ equals the version number

The current location of RateManager:

—— Program Files\Oracle\IGBU\Insbridge\Webs\RM4

]

=
=

<

By pomens T e
File Edit Wew Favorites Tools Help ‘ ’;’
() Back — €3 ~ ¥ |,- Search |Fl? Folders | -

Address ID Iy Documents ﬂ G
Folders ¥ | _MName = | SIZBI Type | Date Modified

[= “e Local Disk (C:) ;I

Figure 10 Location of WorkFiles
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The location of the files to be migrated and the exact file name will depend upon what version of
RateManager you want to migrate. There are two possible locations.

For Release 3.12 and earlier:

e File Name: WorkFiles
e Location: \Program Files\InsBridge\Webs\RMxxx\WorkFiles

Where xxx is the version number, i.e. 310, 311, 312
For Release 3.13:

e File Name: Workfiles
e Location: \Program Files\Oracle\IGBU\Insbridge\Webs\RM313\Workfiles

Copy all work files for every version to be migrated and store in a safe location. In the unlikely
event that an error with the migration occurs, you will have backup files that you can place directly
in the RateManager (RM4) Workfiles location or restore to the previous version.

Performing the Migration in RateManager

This migration process will move rating, pricing, mapping and template files from a previous
version of RateManager to the current RateManager version. You can select the oldest version
that you want to migrate. For example, if you have been running RateManager from version 3.10,
you will have the option to select to migrate from version 3.10 and forward. You also can choose
to migrate from version 3.12.

1. Select Tools->Migrate Work Files. A separate screen will be displayed.

a - Webpage Dialog

-5 Migrate Work Files

Migrate files from: | ERE] +

This migration process will mowve Rating, Pricing, Mappings and Templates from a previous version of
RateManager that you selected to current RateManager, This process could take 2 few minutes to
complete, An alert box will appear when the process has completed.

Miglmel 3 Close |

Figure 11 Migrating Work Files

2. RateManager will determine the possible versions to migrate. Select the oldest version
you want to migrate. You do not have to select the oldest version available. You can
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select a newer version. Only work files from the selected version and newer will be
migrated.
Any version prior to the selected version will not have work files migrated.

3. Click Migrate.

/A Confirm -- Webpage Dialog

™ Al current Rating, Pricing, Mapping and Template files will be deleted in order
_!_./I to migrate the files from the previous RateManager. Do you want to
. continue?

2  Yes | (5 T |

Figure 12 Confirming a Migration

4. Say Yes to migrate. If you are unsure about the action you want to take, click No to stop
the migration process.

The migration will begin. This process could take a few minutes to complete. When all
files have been migrated, an information notice will be displayed.

The process has completed.

1)

Figure 13 Successful Migration

5. Say OK to close the screen.
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Verifying Migrated Files in RateManager

Migrated files will be available in the same areas.

= Oracle Insurance Insbridge RateManager 04.05 - Windows Internet Explorer

ORACLE Insurance Insb ge RateManager Ver
Fle Modues Toos Help
‘7 Home ] a0 Impact Analysis %
I i Batch Files
: B Run Batch File | (5 Open Bateh File = | 3€ Delete | §ff) Refresh
Send Confirmatontos[ | Verson Overndes || Include Debug Reports ] ScftRater Envirenment Override:
File Name Date Modified
[ ‘\bruz13\c\shared\TestCases\LOBZ\Group1\* xxml 2010-10-11T14:17:58 A
D \\Ibru313\c$\shared\TestCazes\LOBL\*.xm| 2010-10-11T14:17:22
D \\bru313\c$\shared\TestCazes\LOB14266001552_01\*.xml 2010-10-11T14:12:46
I:l \WIbru313\c$\shared\TestCases\LOB1\266001552_01\*.xml 2010-02-12T13:40:25
[ ‘\bruz12\cé\shared\TestCases\LOBZ\Groupa\* sxml 2010-02-09T11:56:15
I:l \\Ibru313\c$\shared\TestCases\LOE2\Group3\*.xml 2010-02-09T10:51:43
[ “\bruz13\cé\shared\TestCases\LOBZ\Group2\* xml 2010-02-09T10:51:22
v
Debug | File Name Run By Date Run Policies Size
] Groupl_3.13.6 Company Administrator ~ 2010-10-11T14:19:20 s0 518 KB |
D LOB1_3.13.6 Company Administrator 2010-10-11T14:18:58 88 410 KB T
I:l 266001552_01_11-13-... Company Administrator 2010-10-11T14:12:48 1 5 KB
O =) 266001552_01_11- Company Administrater ~ 2010-10-11T14:01:03 1 432 KB
I:l 266001552_01_11- Company Administrator 2010-10-07T15:36:00 1 5 KB
O =) 266001552_01_11-13-... Company Administrator  2010-10-07T15:35:18 1 432 KB
] [¥]  266001552_01_11-13-... Compzny Administrster  2010-10-07T15:22:15 1 432 KB
D 266001552_01_11-13-... Company Administrator 2010-10-07T15:20:11 1 5 KB
] [¥]  266001552_01_11-13-... Compzny Administrstor  2010-10-07T15:19:34 1 432 KB
D 266001552_01_11-13-... Company Administrator 2010-10-07T14:58:18 1 5 KB
] [#]  266001552_01_11-13-... Compzny Administrster  2010-10-07T14:57:35 1 432 KB
O [¥]  266001552_01_11-13-... Company Administrator  2010-10-07T14:50:41 1 432 KB
D 266001552_01_11-13-... Company Administrator 2010-10-07T714:49:52 1 S KB
D LOB1_3.13.6 Company Administrator 2010-10-07T14:44:20 88 410 KB
D BATCH REGR TEST_20... Batch Regression Test ... 2010-08-11T18:45:32 1 10 KB
D BATCH REGR TEST_Z20... Batch Regression Test ... 2010-08-11T18:45:52 1 10 KB
D BATCH REGR TEST_20. Batch Regression Test 2010-08-11T18:45:52 1 11 KB
D BATCH REGR TEST_20. Batch Regression Test 2010-08-11T18:45:51 1 10 KB
D BATCH REGR TEST_20... Batch Regression Test ... 2010-08-11T18:45:51 1 10 KB
I:l BATCH REGR TEST_Z20... Batch Regression Test ... 2010-08-11T18:45:50 1 10 KB s
Selected Menu Item:  Bztch Files
Batch Files | Reporting \

Figure 14 Verifying File Migration in RateManager

To verify that work files from a previous version have been migrated, enter an area where these
files would be used, such as Impact Analysis.

The tab will refresh with all available files. Your files from previous versions will be listed.
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Verifying the File Migration in the Server

Migrated files will be moved from previous releases into the updated RM4 Workfiles location.

@ C:\Program Files',0racle’ IGBU" Insbridge', Webs'RM4' Workfiles',Mappings', Input',Custom [_ O] I
File Edit Wew Favaorites Tools  Help | ;','
QBack ~ &) - ? | ! Search |f|'_‘ Folders | [
Address I]j| C:\Program FilesiOracle\1GEL InsbridgeWebs R M4\ WorkfilesiMappingsiInput Custom j G0
Folders X | Mame = | Size | Tvpe | Drate: Modified |
3 TERL ;I 313Aut0 Training Manual Tables, xsl: 1 KE ¥5LT File 1110/2011 1:15 AM
= I RM4
) Activex
[T App_Themes
125 bin
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El Connectars
[ Caontrols
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[C5) Images
51 Includes
I3 Licenses
I3 Loginapps
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]f] Service References
3 Leils
|5 videos
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WED [

[C5) ImportDataFiles
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Figure 15 Verifying File Migration at Server Level

You can verify that files have been moved by looking in the
\Program Files\Oracle\IGBU\Insbridge\Webs\RM4\Workfiles folder.

You also can verify that previous WorkFiles have been removed by looking in the prior WorkFile
location on the server.

Workfiles only need to migrated one time.
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MANUAL UPDATES TO THE IBRU DATABASES

In the RateManager, Security, and SoftRater Database folders you will find the current database
scripts. The RateManager and Security database update scripts will take previous IBRM and
IB_CLIENT databases from version 3.13 to version 04.05.00 only. To go from a lower version
up to 04.05.00, you must enter RateManager.

The IBSR database update will need to be run once, regardless of version, in the corresponding
database. If you are updating from a release previous to 3.13, please see Error! Reference
source not found. on page Error! Bookmark not defined..

NOTE: Oracle database updates must be performed directly on the Oracle database by an
Oracle DBA. Improper scripts updates can result in database failures. Oracle database
updates are not available on RateManager.

TO PERFORM DATABASE UPDATES FROM RATEMANAGER

The preferred method of updating the IBRM and IB_CLIENT databases is to go into
RateManager. If the administrator has DB User privileges and is the DB Owner of the database
as well as the disk administrator, database updates can be done on the
Tools>Database->Updates tab. If these privileges are not in place, an error message will be
displayed. See Error! Reference source not found. for instructions.

NOTE: If you need to go from an older version, such as 3.11, it is strongly recommended that
you enter RateManager and run the 3.12, 3.13, 4.0, 4.1 and 4.5 update scripts
successively from there.

To manually update a SQL Server database, you will be required to save off each update and run
them in sequential order in SQL Server. A DBA or a person with the proper permissions will need
to apply the database updates using Query Analyzer.

1. In RateManager, highlight the update you want to run. If you are going from a much lower
version of RateManager, you may have to save multiple files for each database.

2. Click Save Update Script to File. Your computers dialogue box will be displayed. Save
the file to a location of your choice. For IBRM scripts, it is recommended that you rename
the file to usp_IBRM_RO(version number).sgl. For example the R4.0 update would be:
usp_IBRM_RO040.sql. For IB_CLIENT scripts, it is recommended that you rename the file
to usp_IB_CLIENT_RO(version number).sql. For example the R4.0 update would be:
usp_IB_CLIENT_R40.sql.

3. To view the update script prior to execution, highlight the update you want to view. Click
Open Update Script. The update script will be displayed in a separate screen.
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2 IBRU : v04.05.00.00 -- Webpage Dialog

~

-- Constraint
-— foriegn Key
IF NOT EXISTS (SELECT * FROM =sys.indexes WHERE object_id = OBJECT_ID(N' [dbo].
[TYPES_DATA]') AND name = N'PK D5 TYPES Q')

print 'Missing [dbo].[PROGRAMS] Foreign Key [PE DS TYPES Q]°

GO
IF not EXISTS (SELECT * FRCM sys.foreign_ keys WHERE object_id = OBJECT_ID(N'[dbo].
[FE_PROGRLMS S5YSTEM COUNTRIES] ") RND parent object id = OBJECT ID(N'[dbo].
[FROGRAMS] "))

print 'Missing [dbo].[PROGRAMS] Foreign Key [FE_PROGRAMS SYSTEM CCUNTRIES]'

GO
IF not EXISTS (SELECT * FROM sys.foreign_keys WHERE object_id = OBJECT_ID(N'[dbo].
[FE_IMPORT_PROGRAM VALUE TMPCORT FROGRAM] ") AND parent_object_id = OBJECT_ID(N' [dbo].
[IMPORT PROGRAM VALUE]')

print 'Missing [dbo].[IMPCRT PROGEAM VALUE] Foreign Key
[FE_IMPORT_ PROGRAM VALUE TMPCRT FROGRRM'

0]
if NOT exists (select * from dbo.syscobjects where id = object id(N'[dbo].
[FE_IMPORT TEMPLATE PROGRAMS]') and CEJECTFROPERTY (id, N'IsForeignKey') = 1)

print 'Missing [dbo].[IMPORT TEMPFLATE] Foreign Eey
[FE_IMPORT TEMPLATE PROGRAMS]'

GO
if NOT exists (select * from dbho.sysobjects where id = object id(N'[dbo].
[FE_PROGRAM VERSIONS PROGRAMS] ") and OBJECTPROPERTY (id, N'IsForeignKey') = 1)

print ‘'Missing [dbo].[PROGRAM VERSICNS] Foreign EKey
[FE_PROGRAM VERSICNS PROGRAMS]®

GO
IF NOT EXISTS (SELECT * FRCM sys.foreign_ keys WHERE object_id = OBJECT_ID(N' [dbo].
[FE_LOCKUPVARS PROGRAMS]') RND parent object id = CBJECT ID(N'[dbo].[LOCKUF WARS]'})

print ‘'Missing [dbo].[LOOKUF VARS] Foreign Key [FE LOCEUPVARS PROGRAMS]'

GO
IF HNOT EXISTS (S5ELECT * FRCM sys.foreign keys WHERE cobject_id = OBJECT_ID(N'[dbo].
[FE_INSTRUCTICNS GROUPS PROGRAMS]') AND parent object _id = OBJECT ID(N'[dbo].
[(INSTRUCTIONS GROUPS] ")

print 'Mizsing [dbo].[INSTRUCTICNS GROUPS] Foreign Key
[FE_INSTRUCTICNS GROUPS PROGRAMS] ' 2

%
Figure 16 Script Viewer

4. |If this is the script you want to run, open Query Analyzer in SQL Server.

NOTE: If you do not have database permissions, you will not be able to perform the following
database queries.

NOTE: When using Database Engine Query, the SQL scripts must run on each individual
database.

5. Open up the DB script updates from the download file. You can open in any program
you want, such as Notepad. Begin with the next sequential update. For example, if you
are going from R3.13 to 04.05.00, open 4.0 first.
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Figure 17 Updating Database

10.

11.

12.

13.

14.

15.

16.

17.

18.

Select the database you want. In SQL Server Management Studio, create a new
Database Engine Query, File>New=>Database Engine Query.

The query screen will be displayed on the right hand side.

Copy the first update from Notepad and paste onto the query screen.

Click Execute. The script will execute. Any messages will be displayed in the lower
portion of the screen. You must run the updates in sequential order. Run each update
until you run the 04.05.00 update. Then continue on to the next database.

For example, if you want to update the IBRM database in SQL Server, select the IBRM _
database. In SQL Server Management Studio, create a new Database Engine Query,
File>New=>Database Engine Query.

The query screen will be displayed on the right hand side.

Copy the first update from Notepad and paste onto the query screen.

Click Execute. The script will execute. Any messages will be displayed in the lower
portion of the screen. Run each update until you run the 04.05.00 update. Then continue
on to the next database.

For example, if you want to update the IB_CLIENT database in SQL Server, select the
IB_CLIENT database. In SQL Server Management Studio, create a new Database
Engine Query, File>New=->Database Engine Query.

The query screen will be displayed on the right hand side.

Copy the first update from Notepad and paste onto the query screen.

Click Execute. The script will execute. Any messages will be displayed in the lower
portion of the screen. Run each update until you run the 04.05.00 update. Then continue

on to the next database.

After the scripts have been run, return to RateManager. Click Refresh Listing. The
status should show current and the full RateManager menu should be displayed

The updates are now properly applied and users can log back in to the system.
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CONTACTING SUPPORT

If you need assistance with an Oracle Insurance Insbridge Rating and Underwriting System
product, please log a Service Request using My Oracle Support at https://support.oracle.com/.

Address any additional inquiries to:

Oracle Corporation

World Headquarters

500 Oracle Parkway
Redwood Shores, CA 94065
U.S.A.

Worldwide Inquiries:
Phone: +1.650.506.7000
Fax: +1.650.506.7200
oracle.com

TTY ACCESS TO ORACLE SUPPORT SERVICES

Oracle provides dedicated Text Telephone (TTY) access to Oracle Support Services within the
United States of America 24 hours a day, seven days a week. For TTY support, call
800.446.2398.
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